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Scope

These release notes present information about the definition, delivery, and operation
of Rational ClearCase LT configuration management software.

ix



ix Release Notes



Product Definition 1

Rational ClearCase LT software for UNIX operating systems offers client/server
solutions for configuration management software.

Before you install ClearCase LT software, read the Installation Guide for Rational
ClearCase LT.
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What’s New in
ClearCase LT 2

This chapter describes new features and other changes in Version 2003.06.00 of
Rational ClearCase LT, as follows:

� New Features

� Announcements

� Changes to the Commands

� Changes to the Documentation

New Features

The following is a summary of the new features that are introduced in this release of
ClearCase LT:

� ClearCase LT Web

� New and Enhanced Integrations

� UCM Enhancements

ClearCase LT Web

ClearCase LT Web supports the following new features:

� The Rational Web Platform (RWP) is the new server for the Web interface.
ClearCase LT is a CGI executable that runs with the Apache Web server provided
by RWP. Rational no longer supports any other Web server as the server for
this interface. For more information, see the Administrator’s Guide for Rational
ClearCase.

� Support for Mozilla 1.4–based browsers on AIX, and Linux systems. Netscape 7
is supported on Solaris and HP-UX.

� Reverse proxy support. The Web interface allows requests from external users to
be passed through a firewall to an internal ClearCase LT Web server.

� Performance improvement. When you perform an update, load, or restore
operation on a large number of files, the associated Progress page displays either a
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Show Details or Hide Details button. Hiding the details can improve performance
dramatically when several thousand or more file elements are the subjects of
the operation.

� You can create a UCM view based on an existing development stream, even if you
are not the owner of the stream, as long as you are a member of the same group.

� Support for multibyte character sets.

� Support for Sun JVM 1.4.2.

� Full-text search capabilities in Help through the Search tab in the left navigation
pane.

� Using Compare (in ClearCase Properties), you can compare the current version of
an element with any other version. In previous releases, you could compare a
version only with its predecessor.

For complete information, see the Help.

New and Enhanced Integrations

This section describes integrations that are new or enhanced in this release.

WebSphere Studio

This release introduces the integration of ClearCase LT with WebSphere Studio. The
integration supports WebSphere Studio versions 4 and 5.0 running on versions 1.0,
2.0, and 2.1 of the Eclipse shell. For more information, see the Help.

Forte for Java

This release introduces the integration of ClearCase LT with Forte for Java version
3.0. For more information, see the Help.

JBuilder

This release provides support for Borland JBuilder versions 5, 6, and 7. For more
information, see the Help.

UCM-ClearQuest Integration

This release includes the following enhancements to the UCM-ClearQuest integration:

� The integration is now supported on HP-UX 11.11 and AIX.

� GUIs in the style of ClearCase LT on Windows. You can now create activities and
view an activity’s property sheet from within the Checkin, Checkout, and Add to
Source Control dialog boxes. For more information, see the Help.
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� Performance enhancement. This release incorporates changes that reduce the
communications overhead between ClearCase LT and ClearQuest.

� During a deliver operation in a project enabled for ClearQuest that has set the
policy Transition to Complete After Delivery, if any of the activities being delivered
is set to a view, the integration unsets the activity from that view after it transitions
the activity to a Complete type state. For more information, see Managing Software
Projects.

� Format options implemented for this integration enable you to determine
the view set to the UCM activity (%[view]p), the ClearQuest record type
(%[crm_record_type]p), the likeliest view for resolving the names of versions in a
change set (%[name_resolver_view]p), and the name of the ClearQuest database
(%[crm_database]p). See the fmt_ccase reference page.

� You can submit new ClearQuest records using the activity list dialogs. For more
information, see Developing Software.

� New policies provide more flexibility in controlling the behavior of projects
enabled for ClearQuest. For more information, see Managing Software Projects
and the Help.

Base ClearCase-ClearQuest Integration
� This integration supports the association of multiple file imports (by clearfsimport)

with a single change request. For more information, see the clearfsimport
reference page.

� Enhanced capabilities for making ClearQuest associations. The integration lets
you specify a file’s association with a defect or defects by using checkout or
checkin comments that contain a text pattern specified in the environment variable
CQCC_COMMENT_PATTERN, or obtain a list of files to associate with a defect from
the environment variable CQCC_AUTO_ASSOCIATE.

UCM Enhancements

This release includes the following enhancements to UCM:

� Single-stream projects. Customers who prefer a serial, rather than a parallel,
development environment can use single-stream projects. A single-stream project
contains one stream: the integration stream. Developers join the project by creating
an integration view attached to the integration stream. Because developers
work directly on the integration stream, they do not perform deliver or rebase
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operations. Single-stream projects are recommended only for small teams of
developers who work closely together.

� Read-only streams. You can designate specific streams as read-only to prevent
developers from making changes to the stream’s components. For example, you
might create a read-only stream for your release engineering team members so
that they can access a set of baselines without inadvertently making changes to
components.

� Baseline naming templates. Project managers can specify a template to be used
in naming baselines within a project. They construct a baseline naming template
by choosing tokens that represent variables such as project name, component
name, date, and so on.

� Performance enhancements. This release incorporates changes that reduce the
processing and communications overhead for almost all UCM operations.

� Format options for object properties. Formatting options for UCM
object properties enable you to output the initial baseline of a component
(%[initial_bl]Xp), the activities of a baseline (%[activities]Xp), the promotion level
of a baseline (%[plevel]p), the promotion levels defined in the PVOB (%[plevels]),
and whether or not a stream is read-only (%[read_only]p). See the fmt_ccase
reference page.

� Delivering the current activity. The –cactivity option for deliver specifies that the
currently set activity is to be delivered. See the deliver reference page.

� Status button in UCM GUIs. The Deliver from Stream in Progress and Rebase in
Progress GUIs now include a Show Details button. This eliminates the need to
select Properties on the Stream and then click the Status button.

� Determining baseline membership. The lsbl command supports the options
–member_of and –recurse, which enable you to determine whether a baseline is a
member of a composite baseline. See the reference pages for lsbl and fmt_ccase.

� Displaying the activities of a delivery. In the Compare Baselines GUI, you
can right-click a deliver integration activity on the Activities tab to show the
contributing activities that were included in the deliver operation.

For integration activities in projects enabled for ClearQuest, you can click Actions
> Contributors on the ClearQuest record form to display the activities that were
included in the deliver operation.

� Using lsproject to display ClearQuest policies. The lsproject –l command
displays ClearQuest policies for a project that is enabled for ClearQuest. For more
information, see the lsproject reference page.

� Checking PVOB/component relationships. The checkvob command incorporates
functionality for detecting and repairing relationships among a PVOB, a project’s
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components, and for projects that are enabled for ClearQuest, the ClearQuest user
database. For more information, see the Administrator’s Guide and the checkvob
reference page.

� Listing activities by user. You can use the lsactivity command to list only those
activities that are owned by a specified user. See the lsactivity reference page.

� Checking in all versions in an activity’s change set. Using the xclearcase File
Browser, you can click Projects > Checkin All in Current Activity to check in all
versions in the activity’s change set.

� New Events. There are new events that support UCM operations. See the
events_ccase reference page.

For more information, see Managing Software Projects, the reference pages cited in
this section, and the Help.

Mozilla Environment Variables

New environment variables control the Mozilla browser, as follows:

� CCASE_MOZILLA may be set to specify Mozilla as the default browser.

� CCASE_MOZILLA_OPT may be set to pass options to the Mozilla command line.

� CCASE_MOZILLA_NEW_WINDOW may be set to “,new-window” to open a new
window or to “,new-tab” to open a new tab in an existing window.

These environment variables are comparable to the CCASE_NETSCAPE and
CCASE_NETSCAPE_OPT environment variables that are described in the reference
page for xcleardiff. The script display_url.sh treats them as follows:

� If CCASE_MOZILLA is set, the browser that it specifies is used.

� Else if CCASE_NETSCAPE is defined, the browser that it specifies is used.

� If neither CCASE_MOZILLA nor CCASE_NETSCAPE are defined, an attempt is made
to find the Mozilla executable in the search path first. Then, if it cannot be found,
Netscape is used.

Miscellaneous Enhancements

This section describes miscellaneous enhancements in this release.

� Uncataloging elements that have checkouts. By default, the rmname operation
behaves correctly by failing when the element specified to be uncataloged is
checked out. See the rmname reference page.

� Creating elements in view-private directories. The mkelem command supports a
–mkpath option that creates an element from a view-private file or directory that
resides in a view-private directory. The distinctive behavior of this option is that it
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also creates elements from all view-private directories in the element path. See
the mkelem reference page.

� Handling white space during merges. In previous releases, you could ignore
white space when using cleardiff and xcleardiff by means of the –blank_ignore
command-line option or the Ignore white space during merge option in the Diff
Merge Properties window. However, in graphical mode the option was supported
only for comparisons, not merges. At this release, the Ignore white space option
is available during a merge. In addition, the command option –favor_contrib
enables you to specify a contributor to be used for white space formatting of
unchanged lines. For graphical merges, the cleardiff and xcleardiff GUIs display a
list of contributors (Take white space changes from:) from which you can select one
to be used for white-space formatting. See the Help and the reference pages for
cleardiff and xcleardiff.

� Multiple mount points for paths to remote storage. The environment variable
CCASE_GPATH_HINTS enables you to specify a set of NFS mount points that
mkview, mkvob and mkstgloc try when attempting to construct pathnames to
remote storage. See the env_ccase reference page.

� Checkins from merge dialog box. The dialog box for merge operations includes
an option for checking in merged element versions. For details, see the Help.

� Redisplaying merge session transcripts. The Display Transcript command
redisplays a merge session transcript after the merge session is completed and the
transcript dismissed. This command is available from the View menu.

� Ignoring signal handlers. User settings to ignore signal handlers for SIGINT,
SIGHUP, and SIGTERM are honored by cleartool and multitool. Previously,
they had been replaced by program internal handlers. User signal handlers that
are not SIG_IGN will still be replaced.

� Refreshing selected elements during a merge. Refreshing a large number of
elements during a merge can be a time-consuming operation. Now you can
also specify that only certain elements are to be refreshed. The Refresh Selected
Elements menu option is available from the Merge menu and in the pop-up menu
for an individual item in the merge manager log.

� Object name restriction relaxed. The restriction on object names that disallowed
numerics values has been relaxed such that only integers are disallowed. The data
converters (the commands that are prefixed clearexport_) have been modified to
take advantage of this change. For information about object naming rules, see
the cleartool reference page.
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Announcements

This section contains announcements, as follows:

� Status of the Feature Level

� Distribution of Perl Extension

� Perl Software Distributions in This Release

� UCM-ClearQuest Integration Support for UCM Packages

� Miscellaneous Announcements

Status of the Feature Level

This release introduces feature level 4. Table 1 shows all supported feature levels and
the versions at which they were introduced.

Table 1 Feature Levels and ClearCase LT Versions

Feature level Introduced in version

2 4.0

3 2002.05.00

4 2003.06.00

Feature level 3 placed constraints on client/server compatibility in UCM
environments. Feature level 4 introduces no additional constraint; it is equivalent to
feature level 3 in terms of PVOB client/server compatibility. For information about
feature level 3, see the Version 2002.05.00 Release Notes for your product. Also note
that read-only streams and single-stream projects are restricted to PVOBs at feature
levels 3 and higher (see the reference page for mkstream).

Raising the feature level to 4 results in the following changes in the VOB:

� The predefined element types xml, html, and rose (if they exist) are renamed to
xml_v5.0, html_v5.0, and rose_v5.0, respectively. Similarly, element type names
that you have changed are renamed to name_v5.0. The v5.0 types lose their status
as well-known element types. Accordingly, when you create new elements, the
file-to-type mapping mechanism no longer treats these types as the defaults (see
the cc.magic reference page). The type of an existing element does not change;
however, you can use chtype to change it.

� The new predefined element types xml, html, and rose are created. The purpose
of replacing these types is to base the type managers on the binary_delta type
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manager instead of the text_file_delta manager. The cc.magic file maps new
elements to these types by default.

For instructions about raising the feature level of a VOB, see the chflevel reference
page.

Distribution of Perl Extension

ClearCase::CtCmd is a Perl extension that takes cleartool–like arguments.
ClearCase::CtCmd takes a string or an array as an input argument and returns a
three-element Perl array, as follows: a status bit, a scalar string corresponding to
stdout, and any error message corresponding to stderr. This Perl extension and its
documentation are available from www.cpan.org.

Note: After upgrading to Version 2003.06.00, you must rebuild ClearCase::CtCmd
to account for the addition of new libraries and symbols to ClearCase LT

Perl Software Distributions in This Release

Perl 5.6.1 is distributed with ClearCase LT. Perl 4 is not included in this release. For
backward compatibility, this release also includes a modified version of Perl 5.002. To
use 5.002 instead of Perl 5.6.1, set CCASE_USEPERL5 to a nonempty string (see the
env_ccase reference page). To verify the version that is being invoked, type ccperl
–ver.

In conformance with the Artistic License Agreement under the terms of which Perl is
distributed, Table 2 describes the modifications that were made to Perl 5.6.1.

Table 2 Modifications to 5.6.1 Perl Distribution

Reason for modification

Modification Source file modified

Changed to use native AIX dlopen() functions. makedef.pl, dl_aix.xs

Accommodation of underlying C library changes or other OS changes

Add libmalloc, libndir to link list hints/hpux.sh

Use Rational naming conventions

Configure. Add prompt for executable name Configure

Allow arbitrary link library path Makefile.SH

Allow arbitrary executable and library name Makefile.SH, installperl

Defect fixes independent of public domain
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Table 2 Modifications to 5.6.1 Perl Distribution (Continued)

Reason for modification

Modification Source file modified

Do not free environment in perl_destruct when
–DPERL_USE_SAFE_PUTENV

perl.c

Do not free environment in Perl_my_setenv when
–DPERL_USE_SAFE_PUTENV

util.c

Compiler related changes

Allow C++ compiler on Sun5 Configure

Likewise, in conformance with the Artistic License Agreement Table 3 describes the
modifications that were made to Perl 5.002.

Table 3 Modifications to 5.002 Perl Distribution

Reason for modification

Modification Source file modified

Accommodation of underlying C library changes or other OS changes

Fix AIX 4.2 relocation defect dl_aix.xs

Perl dynaloader not initializing C++ shared
libraries

dl_hpux10.xs

New functions and other changes needed by the embedded ClearGuide interpreter

Fix hang when invoked from ClearGuide dl_dlopen_C++_sun4.xs

Changes related to ClearGuide modules

Put __END__ at end so Autosplitter succeeds DynaLoader.pm

Inclusion of changes/upgrades from public domain to sources

5.005_62 BPD rule dumps core dl_aix.xs, cop.h, pp_ctl.c,
pp_hot.c

5.004_04 Allow sigaction() in sig handlers util.c

Defect fixes independent of public domain

Fix to allow debugging pp_ctl.c

Fix to build of miniperl to fix Linux core dump perl.c

Fix sprintf for Aix 4.2/3 doop.c, pp_sys.c
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Table 3 Modifications to 5.002 Perl Distribution (Continued)

Reason for modification

Modification Source file modified

AIX dynaloader; always call loadAndInit dl_aix.xs

Removed misleading error message dl_dlopen_C++_sun4.xs

Compiler related changes

Fixes to allow certain new compilers to function proto.h, perl.h

Use cxxshl_ routines to handle C++ static
initializers

dl_hpux.xs, dl_hpux10.xs

Support aCC dl_hpux10.xs

Remove comment characters from within
comments to quiet AIX compiler warnings

unixish.h

Change in build or test environment to Perl modules as shipped

Test harness fix ParseWords.pm

Fix autoloading ParseWords.pm

Version related changes

Remove v5.004 test HTML.pm, Entities.pm

Remove use strict for use by Perl 5.002 HTML.pm, Parser.pm

This release is the last major release that includes 5.002. The unmodified sources
for Perl versions 5.002 and 5.61, as well as the binaries built from them, may be
downloaded from http://www-3.ibm.com/software/awdtools/clearcase/support/index.html.

UCM-ClearQuest Integration Support for UCM Packages

In the Project Properties and New Project Wizard GUIs, the ClearQuest page displays
the policies that are appropriate for the UCM level of the ClearQuest user database
associated with the project. If the ClearQuest user database uses the revision 5.0
UCM package (corresponding to Version 2003.06.00), the available policies are as
documented in the Help and in Managing Software Projects.

If the ClearQuest user database uses an earlier UCM package, the available policies
are as follows:

� For UCM package revision 2.0:
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� Check assignment before WorkOn

� Check before ClearCase delivery

� Do ClearQuest action after delivery

� For UCM package revisions 3.0 and 4.0:

� Check assignment before WorkOn

� Check before ClearCase delivery

� Do ClearQuest action after delivery

Miscellaneous Announcements

This section contains miscellaneous announcements about this release.

Change in Installation and Administration Directories

The default installation directory has been changed from /usr/atria to
/opt/rational/clearcase. The administration directory has been changed from
/var/adm/atria to /var/adm/rational/clearcase.

Manipulation of Directories When Upgrading from Version
2002.05.00 to 2003.06.00

During an upgrade from Version 2002.05.00 to 2003.06.00, the installation tool
moves /var/adm/atria to /var/adm/atria.preserve. Critical files are moved back
to /var/adm/rational/clearcase when the installation is complete. Other files or
customizations stored in this directory remain in /var/adm/atria.preserve after the
installation is complete.

CLEARCASE_OBSO_SYN Not Supported

The environment variable, CLEARCASE_OBSO_SYN, is not supported in this release.

Removal of the Term “atria”

The following changes were made to remove the term atria:

� The default installation directory has been changed from /usr/atria to
/opt/rational/clearcase.

� The administration directory has been changed from /var/adm/atria to
/var/adm/rational/clearcase.
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� The environment variable ATRIAHOME has been renamed CLEARCASEHOME.

� The startup/shutdown scripts rc.atria and atria have been renamed rc.clearcase
and clearcase, respectively. Symbolic links from the old names have been
established for this release.

Examples Removed

Except for ClearCase LT API examples, the examples in ccase-home-dir/examples have
been removed.

Available Versions of ClearCase LT–ClearQuest Integrations

The ClearQuest Configuration tool (cqconfig) offers the administrator a choice of
the V1 (previous) integration or the V2 (new) integration implementation, allowing
administrators to migrate to the new integration as appropriate. The default values
were set to V2 on UNIX (because V2 was a superset of the V1 implementation) and
to V1 on Windows (because the V1 integration had a GUI interface that V2 initially
lacked). In this release, the V2 GUI is now available in all circumstances making it as
functionally complete as the V1 Windows integration. Accordingly, the default for
Windows is now set to V2. Administrators can still select V1.

Browser Support for ClearCase LT Web Interface

The Web interface no longer supports Netscape 4.7. For information about browser
support for the Web interface, see the Installation Guide for Rational ClearCase LT.

Changes to the Commands

This section describes changes to the ClearCase LT command set.

New Commands

This release introduces no new commands.

New Options and Arguments

Table 4 lists new options and arguments to commands.
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Table 4 New Options and Arguments

Command New option/argument Use

–view view-tag Transitions an activity in the specified
view.

chactivity

–cqaction { –cact |
activity-selector ... }

In a single-stream project, checks in the
versions in the change set of an activity
and closes the activity if the relevant
ClearQuest policies have been set.

–ucm Runs checkvob in UCM mode.

–view view-tag Uses the view specified in view-tag.

–log log-dir-pname Specifies an alternative directory for the
log file directory.

–fix [ –force ] Directs checkvob to try to correct any
problems it finds. Without –force, –fix
prompts you before fixing any problem
object.

–verbose Specifies verbose output.

–crm_only Examines only references to records in a
ClearQuest database

–vob_only Examines only references to objects in
components.

–component
component-selector

Further restricts a –vob_only check to the
component specified by component-selector

object-selector... Specifies the object types that are to be
checked.

–crm_dbname
user-database-name

Checks the references held in the
ClearQuest database specified by
user-database-name.

–activity cq-display-name Checks the references held by the activity
record specified in cq-display-name.

checkvob

–project cq-display-name Checks the references held by the project
record specified in cq-display-name.

chproject –blname_template
baseline-naming-template

Defines the baseline name template for a
project.
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Table 4 New Options and Arguments (Continued)

Command New option/argument Use

chstream –cview Specifies the stream connected to the
current view to be modified.

–reset –to integration-view-
tag

Resets a new integration view so that you
can cancel, resume, or complete a deliver
operation after the integration view is lost
during a deliver operation.

deliver

–cactivity Specifies that the currently set activity is
to be delivered.

–tiny Same as –window, but uses a smaller font
in a 165-character difference window.

diff

–window Displays output in a separate difference
window.

diffbl –nmerge Specifies that no merge is to be performed.

-me Displays activities owned by the current
user.

lsactivity

–user user Displays activities owned by the specified
user.

lsbl -member_of [ –recurse ] Used by itself, displays the composite
baselines of which each baseline is a direct
member. Used with the -recurse option,
displays all baselines of which each
baseline is a direct or indirect member.

lsstream –in { project-selector |
stream-selector }

Displays a list of all streams for the
specified project, or a list of child streams
for the specified stream.

mkbl –view view-tag Specifies the view from which to create
baselines.

mkdir –master Assigns mastership of the main branch
of the directory element to the VOB
replica in which you execute the mkdir
command.
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Table 4 New Options and Arguments (Continued)

Command New option/argument Use

mkelem –mkpath For an element that is being created from
a view-private file or directory, this option
creates elements from its view-private
parent directories.

mkproject –model { SIMPLE |
DEFAULT }

Sets the project model. SIMPLE: A
single-stream project; DEFAULT: A
multiple-stream project.

mkstream –readonly Creates a read-only stream.

pro-
tectvob

pname-in-vob Pathname of the VOB tag or of any file
system object within the VOB.

Obsolete Command, Options, and Arguments

The clearexport_ffile command was announced as obsolete in version 2002.05.00;
it has been removed from the product.

The dir argument to annotate and the –glossary option for apropos are obsolete.

Changes to Command Output

Significant changes to command output are as follows:

� The event comment for the rmname operation has been changed from Removed

file element to Uncataloged file elementto reflect the nature of the operation
more accurately and distinguish it more clearly from the rmelem operation.

� Dates in log files are written in ISO format. Logs reside in /var/adm

/rational/clearcase/log/.

� Output from the schedule command uses ISO dates regardless of any specified
date format preference.

Changed Commands

Commands that have changed in one or more respects are as follows: annotate,
apropos, chactivity, checkvob, chproject, chstream, deliver, describe, diff, diffbl,
find, lsactivity, lsbl, lsstream, lstype, man, mkbl, mkdir, mkelem, mkproject,
mkstream, protectvob, rebase, rmname, schedule. For details, see the corresponding
reference pages.
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Changes to the Documentation

This section describes noteworthy changes to the documentation.

HTML Help

Most Help, including reference pages, is HTML.

Command Reference

The following reference page has been removed from the Command Reference:

� The reference page for ClearCase::CtCmd has been removed; for information about
this Perl extension, see the Comprehensive Perl Archive Network (www.cpan.org).

Administrator’s Guide

The Administrator’s Guide contains new information about backing up and restoring
ClearCase LT and ClearQuest data together.

Tutorial

The script-driven tutorial has been replaced with an HTML tutorial without scripts.

Managing Software Projects

A platform-independent edition of Managing Software Projects replaces the separate
UNIX and Windows editions that were published at earlier releases.

Location of Files

Manuals in Portable Document Format (PDF) are installed in ccase-home-dir/doc/books.
In previous releases, they were installed in ccase-home-dir/doc/hlp.
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Restrictions and
Guidelines for Using
ClearCase LT

3

This section explains restrictions and guidelines affecting the use of Rational
ClearCase Version 2003.06.00 software that are considered noteworthy. These are
not necessarily considered defects because the behavior reported is not expected to
change in a future release of the product.

This section also describes significant problems with the documentation and includes
documentation that was inadvertantly omitted from the manuals or Help.

Copyright Information

In some cases, you will not be able to view the Rational copyright information online.
If you want to see this information, you can find it on the ClearCase LT product CD
under doc/ClearCaseLT/legal_information.html.

Install-Related Restrictions

This section describes restrictions related to the installation of ClearCase LT.

Install Scripts and Obsolete German Locales

Some German locales are obsolete, such as De, De_DE.646, De_DE.646@EU, and
De_DE.646@TE. If the current locale is set to one of these obsolete versions, the install
scripts may abort with a syntax error. If this occurs, you must select and set a new
locale before rerunning the installation.

ClearCase Mainframe Connectors Remote Build Server Requirements

The updated Remote Build server requirements for ClearCase Mainframe Connectors
can be found in the Rational ClearCase Mainframe Connectors User’s Guide. The Remote
Build server requirements published in the Installation Guide are incorrect.

RWP Default Port Changed for Linux x86 Systems

On Linux for x86 installations, the default port number for RWP has been changed
from 80 to 81. This avoids a conflict that was found on some systems.
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Red Hat Linux Must be Set to Non-Unicode Locale

By default, Red Hat Linux 8.0, and 9, and Red Hat Enterprise Linux 3.0 set the
locale to a Unicode locale, en_US.UTF-8 for US installations, and may also do so for
international installations. ClearCase currently does not support Unicode locales.

For ClearCase to function correctly, the locale must be explicitly set to a non-Unicode
locale. Possible locales to use are the C locale, en_US.iso885915, or a locale that was
used successfully in earlier Red Hat Releases.

ClearCase LT Web

This section describes limitations on and guidelines for using the ClearCase LT Web
product.

Netscape Versions for ClearCase LT Web and Other Rational Suite
Products

The ClearCase LT Web product on Solaris and HP-UX requires Netscape 7. However,
the rest of the Rational Suite products require Netscape 4.78, and are not guaranteed
to work correctly on Netscape 7. If you use ClearCase LT Web and another Rational
Suite product, use Netscape 7 as your ClearCase LT Web browser, but do not modify
your PATH.

Load Rule Scopes

For the Web interface, snapshot view config spec load rules are specified differently
from the way they are specified for the native interface. The keyword load is not
needed in the Load rule scopes portion of the config spec for the Web client.

Compare/Merge Operations Limited to text_file Elements

The Compare and Merge operations are limited to elements of type text_file. Attempts
to perform these operations on other types will fail.

Using Special Characters on Non-ASCII Operating Systems

Using special characters on non-ASCII operating systems can cause server output
to be corrupted or the server to crash.

For example, the Shift-JIS double-byte tilde character (FULLWIDTH TILDE), which
is used to indicate “Copy of” in the Japanese Windows environment, can cause this
problem. The problem originates in differences between the Unicode conversion
tables used by ICU (the publicly available Unicode software currently used by the
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Web interface) and the base operating system. The ICU Shift-JIS conversion table
maps FULLWIDTH TILDE to WAVE DASH.

Relationship Between Pathnames and Hyperlinks

Pathnames that refer to files in your Web view are normally presented as hyperlinks.
However, the Netscape 7 and Mozilla browsers enforce more stringent security
restrictions than do other browsers. In these browsers, pathnames are not presented
as hyperlinks because they cannot be traversed.

Handling SSL Warnings

When running the Web interface under SSL, the browser displays warning messages
such as You are leaving a secure site. For example, in the VOB View, this may
happen when you click a file name to view the file. The reason for the warning
message is that a new window is opened to view the local file under the file protocol
rather than under HTTPS. However, if you choose to view the same file by clicking
View on the Properties page, a new window is opened under HTTPS, returning to the
server, and the warning message does not appear.

You can safely ignore these warning messages because all client/server
communications in the Web interface are encrypted. To disable the warning messages:

1 Click Edit > Preferences > Privacy & Security > SSL.

2 In the SSL Warnings section of the SSL page, clear all check boxes.

Web Client Can Be Very Slow When Browsing Large Directories

The Rational ClearCase LT Web client can be very slow when browsing large
directories, especially when your client PC has a slow CPU or limited RAM. For
example, on an 800 MHz PC with sufficient RAM, a 1500 entry directory can take
approximately 2 minutes to render.

To work around this situation, use one of the following workarounds:

� Smaller directories

� A client PC with a faster processor speed

� If you are running ClearCase LT Version 2003.06.00, a Mozilla based browser.
Mozilla based browsers seem to be faster than Microsoft Internet Explorer when
browsing large directories.

Browser Pop-up Windows

When using the ClearCase LT Web client, display of pop-up windows must be
enabled in your browser.
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ClearCase LT-ClearQuest Integration

This section describes restrictions that affect the ClearCase LT–ClearQuest integration.

Activity Link with ClearQuest Record (UCM-ClearQuest Integration)

When a ClearCase activity in a project enabled for ClearQuest is linked to a
ClearQuest record, the Name of the ClearCase activity is set to match the ClearQuest
record’s ID. This allows you to access the corresponding activity when you are
working on a defect by using the current defect number. For example, you can use
the command, cleartool setactivity ClearQuest-record-ID.

It is recommended that you do not change the name of a ClearCase activity, although
ClearCase does not prevent that. If you change an activity name, you cannot use the
setactivity command as already described.

Note that the Headline field for a ClearCase activity is synchronized with the
corresponding field in a ClearQuest record. That is, if you change this field from
within either ClearCase or ClearQuest, the corresponding field in the ClearQuest
record or ClearCase activity is modified as well.

Naming dbsets (UCM-ClearQuest Integration)

When assigning names to dbsets, follow these rules:

� If you have only one dbset, you can name it as you want.

� If you have multiple dbsets, the dbset that is to be associated with the integration
should, if possible, be named the ClearQuest version that you are using; for
example, 2003.06.00.

� If you have multiple dbsets and none of them can be assigned the name of the
ClearQuest version string, stop the clients and set the SQUID_DBSET environment
variable as follows: setenv SQUID_DBSET dbset-name. Then restart the clients.

Use of Rootless UCM Components

It is no longer possible to make a baseline in a rootless component that is not
modifiable. Making a baseline of a composite component for the purpose of changing
its members is regarded as making a modification in a component. A rootless
component should be modifiable except in the following circumstances:

� The component is to hold only nonmodifiable members.

� No baseline is ever to be made in the component.
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Required Patch for Mixed-Version UCM Environments

In UCM environments that support both 2002.05.00 and 2003.06.00 hosts, 2002.05.00
hosts must apply patch clearcase_p2002.05.00–13 or later. These patches provide
support for the new project policies introduced in 2003.06.00.

Disabled Japanese Text Input in Red Hat Linux GUI

The standard method to toggle between English and Japanese text input mode in Red
Hat Linux GUIs is to type SHIFT SPACE. This method does not work in ClearCase
GUIs. Until the problem is fixed in a later release, the following procedure is
recommended to enable Japanese input on all ClearCase GUIs:

1 Open the .Xdefaults file in your home directory. If the file does not exist, create it.

2 Add the following entry:

*inputMethod: kinput2

3 Save the .Xdefaults file.

4 On the command line, type xrdb -q.

5 If the message displayed does not confirm that the kinput2 entry is listed in
.Xdefault, type the command, xrdb .Xdefaults to make the change take effect.

Japanese Linux GUIs Cannot Use kterm in a View

GUIs that need to use the kterm multi-byte terminal display in Japanese Linux are not
able to do so when set into a view. For example, in a view context, you cannot open
a file that is under ClearCase control using a screen editor. To use multi-byte kterm
applications, specifiy view-extended path names instead of setting into a view.

Galaxy-based Unix applets not Level 2 or Level 3 compliant

The Galaxy-based Unix applets in ClearCase use third-party libraries that have
not been internationalized. Use the command line for Galaxy applications, such as
cleardescribe, cleargetlog and clearvobadmin.
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Problems with the Documentation

This section describes significant problems with the documentation and supplies
documentation that is missing from the manuals or the Help.

Browsing the Documentation with Netscape Navigator

If you use Netscape to browse HTML documentation, Netscape 7 is recommended.

Omissions from the Command Reference

The diffbl reference page does not describe the -nmerge option. The correct syntax
for the first two usage modes of diffbl is as follows:

� Display differences between two baselines or streams nongraphically:

diffbl [ -activities ] [ -versions ] [ -baselines ] [ -first_only]

[ -nrecurse ] [ -nmerge ] { baseline-selector1 | stream-selector1 } { baseline-selector2 |
stream-selector2 }

� Display differences between the specified baseline and its predecessor baseline
nongraphically:

diffbl -predecessor [ -activities ] [ -versions ] [ -nrecurse ]

[ -nmerge ] baseline-selector

The -nmerge option is used to compare two baselines on the same stream and reports
only activity and version changes made on that stream.

The protectvob reference page does not describe the pname-in-vob argument. The
correct syntax for this command is as follows:

protectvob [ -force ] [ -chown user ] [ -chgrp group ] [ -add_group group[,...]

[ -delete_group group[,...] ] vob-storage-pname | pname-in-vob } ...

pname-in-vob can be the pathname of the VOB tag (whether or not the VOB is mounted)
or of any file system object within the VOB (if the VOB is mounted). It cannot be the
pathname of the VOB storage directory.

The checkvob –ucm command supports a –verbose option, which directs the
command to generate more detailed output.

Omission from the Administrator’s Guide

The information that follows was omitted from the Administrator’s Guide.
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If you install Rational Web Platform (RWP) on a host that was previously using a
different HTTP server to support version 4.2 or version 2002.05.00 of the ClearCase
Web interface and if that HTTP server must continue to run on that host to support
other applications, you must do the following:

1 Ensure that RWP and the existing HTTP server do not have any port conflicts.
(This topic is treated in the Administrator’s Guide.)

2 Reconfigure the existing HTTP server to redirect Web interface requests to RWP.
(For information about how to do this, see the documentation for your HTTP
server.)

Omission from Managing Software Projects

The discussion of enabling a schema to work with UCM in Managing Software Projects
for Rational ClearCase omits an important step: mapping states to state types.

When you apply the BaseCMActivity package to a schema, ClearQuest adds the
BaseCMActivity record type. When you apply the UnitedChangeManagement (UCM)
packages to the schema, ClearQuest adds the UCMUtilityActivity record type. But
when you attempt to check in the schema with these changes, ClearQuest displays
a series of validation errors stating that you need to map BaseCMActivity states to
the AMStates Types package.

You receive this error because, in applying the UCM package to the schema,
ClearQuest also applied the AMState Types package. This behavior is not described in
the Administrator’s Guide for Rational ClearQuest or in Managing Software Projects.

Before you can check in the schema, you must map states to state types from the
AMStates Types to the BaseCMActivity record type, as follows:

1 In ClearQuest Designer, click Package > Setup State Types.

2 In the Setup States Type dialog box, select a State Type for each State listed.

3 Click Finish.

4 Click File > Check in to record your changes in the schema.

For more information about mapping states and state types, see the Administrator’s
Guide for Rational ClearQuest. For more information about enabling the
BaseCMActivity record type, consult the Rational Support Knowledge Database.

Chapter 3 - Restrictions and Guidelines for Using ClearCase LT 25



26 Release Notes



Status of
ClearCase LT
Software Change
Requests

4

Noteworthy problems found in or resolved in Version 2003.06.00 of Rational
ClearCase LT are listed in the file cc_issues.htm.

You can find this file in the directory ccase-home-dir/install/ after you install the product.
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Contacting Rational
Technical Support 5

If you have any problems with the software or documentation, contact
Rational Customer Support by telephone or fax. You can find information
about support hours, languages spoken, or other support information at
www.ibm.com/software/rational/support/.

Your location Telephone Facsimile

Asia Pacific +61-2-9419-0111
Australia

+61-2-9419-0123
Australia

Europe, Middle
East, and Africa

+31-(0)20-4546-200 Netherlands +31-(0)20-4546-201 Netherlands

Latin America and
Mexico

+1-408-863-4000
Cupertino, CA

Use either location: +1-408-863-
4194
Cupertino, CA

+1-781-676-2460
Lexington, MA

United States and
Canada

1-800-IBM-SERV Use either location: 1-408-863-4194
Cupertino, CA

1-781-676-2460
Lexington, MA
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